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1. Introduction 

Activation of T-lymphocytes is a hallmark of adaptive immunity. Vaccines and 

immunotherapies activate T-cells as part of their intended mechanism of action [1, 2]. In 

contrast, undesirable activation of T-cells underlies hypersensitivity and autoimmune reactions 

[3, 4]. Therefore, monitoring T-cell activation provides a crucial mechanistic insight into both 

healthy and pathological conditions and is of interest for preclinical efficacy and safety studies 

along the drug development process. Activation of T lymphocytes can be detected by monitoring 

two cytokine biomarkers—interferon gamma (IFNγ) and interleukin 2 (IL-2). The detection of 

these cytokines, produced by immune cells exposed to drugs, immunotherapy, or vaccine 

products, aids in preclinical efficacy and safety studies. 

IFN-γ and IL-2 can be detected using traditional single-plex enzyme-linked immunosorbent 

assay (ELISA), single-spot Enzyme-Linked Immunosorbent Spot (ELISpot) assay, or single-spot 

Fluorescent Enzyme-Linked Immunosorbent Spot (FLUOROSpot) assay, each of which analyzes 

one cytokine at a time. Alternatively, both cytokines can be detected simultaneously using either 

a multiplex ELISA or a dual-spot FLUOROSpot assay. Both the ELISpot and FLUROSpot 

formats are helpful to verify the results of traditional and multiplex ELISAs. Advantages and 

limitations of the ELISpot assay vs. multiplex ELISA have been discussed elsewhere [5]. This 

document describes a protocol for the simultaneous detection of IL-2 and IFNγ using a dual-spot 

FLUOROSpot assay, which is based on an interlaboratory study described earlier [6].  

 

2. Principles 

In this protocol, human peripheral blood mononuclear cells (PBMCs) from healthy donor 

volunteers are exposed to controls and test samples for 24 hours on 96-well FLUOROSpot plates 

pre-coated with IFNγ and IL-2 capture antibodies. At the end of the incubation, the cells are 

washed away, and cytokines captured by the antibodies immobilized on the FLUOROSpot plate 

are detected using two levels of detection reagents. First, FITC-labeled IFNγ detection antibody 

and biotin-labeled IL-2 detection antibody are added to the plates. Next, after plate washing, 

anti-FITC antibody conjugated to a green fluorescent label and Cy3-strepavidin are added to the 

plate. The result of these detection steps is the formation of green and red colored spots for IFNγ 

and IL-2, respectively, when the plate is analyzed using one fluorescent light at a time, detecting 
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green and red fluorescence. These colors co-localize and result in a yellow spot when IFNγ and 

IL-2 are produced by the same cell and analyzed using both red and green fluorescent channels 

simultaneously. The spots are quantified using a MultiSpot reader, which produces two 

readouts—the number of spots and activity—for each color separately, and allows for 

monitoring double-positive cells, i.e., those producing both cytokines. The number of spots 

reflects the number of cells that produce cytokines. The activity readout reflects the brightness of 

the fluorescent color and, therefore, indicates the quantity of the cytokine produced by a single 

cell. This protocol utilizes freshly isolated PBMCs, the AID IFNγ/IL-2 dual spot FLUOROSpot 

kit, and the AID multispot reader for plate analysis. Experimental steps involving instrument 

settings, plate reading, and analysis are based on a series of technical documents by Autoimmun 

Diagnostika GmbH [7-11]. When other cells, kits, and instruments are used for this analysis, the 

assay principle will not change; however, some experimental parameters such as seeding cell 

density, length of the incubation, fluorescent labels and detection channels, and spot analysis 

algorithm may need to be adjusted.  

 

3. Reagents, Materials, Cell Lines, and Equipment 

Note:  The NCL does not endorse any of the suppliers listed below; these reagents were used 

in the development of the protocol and their inclusion is for informational purposes only. 

Equivalent supplies from alternate vendors can be substituted. Please note that suppliers 

may undergo a name change due to a variety of factors. Brands and part numbers typically 

remain consistent but may also change over time. 

 

3.1 Reagents 

3.1.1 iSpot human IFNγ/IL-2 Kit (AID, ELSP 5710 or ELSP 5810) 

3.1.2 RPMI-1640 (Cytiva, HyClone, SH30096.01)  

3.1.3 Penicillin streptomycin solution (Cytiva, Hyclone, SV30010) 

3.1.4 L-glutamine (Cytiva, Hyclone, SH30034.01) 

3.1.5 Fetal bovine serum (FBS) (Cytiva, Hyclone, SH30070.03) 

3.1.6 Phosphate buffered saline (PBS) (Cytiva, SH30256.01) 

3.1.7 Trypan Blue solution (Gibco, 15250-061) 

3.1.8 Phytohemaglutinin M (PHA-M) (Sigma, L8902) 
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3.1.9 Sterile distilled water 

3.2 Materials 

3.2.1 Pipettes covering the range of 0.05 to 10 mL 

3.2.2 Polypropylene tubes, 50 and 15 mL 

3.2.3 Reagent reservoirs 

3.3 Equipment 

3.3.1 Centrifuge  

3.3.2 Refrigerator, 2–8ºC 

3.3.3 Freezer, -20ºC 

3.3.4 Cell culture incubator with 5% CO2 and 95% humidity 

3.3.5 37ºC water bath 

3.3.6 Biohazard safety cabinet approved for level II handling of biological 

material 

3.3.7 Inverted microscope 

3.3.8 Vortex 

3.3.9 Hemocytometer or automated cell counter 

3.3.10 AID multispot reader 

 
4. Preparation of Reagents and Controls for Cell Culture 

4.1 Complete RPMI-1640 Medium  

10% FBS (heat-inactivated) 

2 mM L-glutamine 

100 U/mL penicillin 

100 µg/mL streptomycin sulfate 

Store at 2–8ºC protected from light for no longer than 1 month. Before use, warm 

in a water bath. 

4.2 Heat-inactivated Fetal Bovine Serum 

Thaw a bottle of FBS at room temperature, or overnight at 2–8ºC, and allow to 

equilibrate to room temperature. Incubate 30 minutes at 56ºC in a water bath, 

mixing every 5 minutes. Fifty (50) mL single-use aliquots may be stored at 2–8ºC 

for up to one month or at a nominal temperature of -20ºC indefinitely. 
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4.3 Negative Control 

Use PBS as a negative control. Process it the same way as your study samples. 

4.4 Positive Control 

PHA-M at a final concentration of 10 µg/mL is used as a positive control in this 

assay. The stock with a concentration of 1 mg/mL can be prepared in water and 

stored in small, single-use aliquots at -20°C. On the day of the experiment, 

prepare a working stock by thawing a frozen 1 mg/mL stock aliquot at room 

temperature and diluting it to 20 µg/mL in complete cell culture medium (e.g., by 

mixing 20 µL of the 1 mg/mL stock with 980 µL of the culture medium). 

Note: Other T cell agonists, such as concanavalin A, PMA/Ca2+ ionophore, and 

anti-CD3 antibody alone or in combination with anti-CD28 antibody can also be 

used at relevant concentrations. 

4.5 Vehicle Control 

Vehicle control is the buffer or medium used to formulate test nanomaterials. 

Common excipients used in nanoformulations are trehalose, sucrose, and albumin. 

However, other reagents and materials are also used alone or in combination. 

Vehicle control should match the formulation buffer of the test nanomaterial by 

both composition and concentration. This control can be skipped if nanoparticles 

are stored in PBS. 

 
5. Preparation of Study Samples 

The required amounts of nanoparticles will depend on the number of concentrations tested, 

the number of replicates, and the nanoparticle stock concentration. The minimum required 

dilution (MRD) of this assay is 2; therefore, the working stock concentration of the test sample 

should be twice as high as the final concentration desired for analysis in this assay. For example, 

if one desires to test nanoparticles at 1 mg/mL, the working stock concentration should be 2 

mg/mL prepared in the cell culture medium. The recommended minimum volume of the working 

stock is 800 μL for analysis of cultures derived from 3 donors (100 μL per well in duplicate, plus 

extra to prepare dilutions and account for dead volume of pipette tips and sample tubes). A 

strategy for the estimation of nanoparticle test concentrations for in vitro testing has been 

discussed elsewhere [12].  
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6. PBMC Preparation 

6.1 Place freshly drawn blood into 15- or 50-mL conical centrifuge tubes, add an 

equal volume of room-temperature PBS and mix well.  

6.2 Slowly layer the Ficoll-Paque solution underneath the blood/PBS mixture by 

placing the tip of the pipet containing Ficoll-Paque at the bottom of the blood 

sample tube. Alternatively, the blood/PBS mixture may be slowly layered over 

the Ficoll-Paque solution. Use 3 mL of Ficoll-Paque solution per 4 mL of 

blood/PBS mixture. For example, 15 mL Ficoll-Paque per 20 mL of diluted blood 

in a 50 mL tube. 

Note: To maintain the Ficoll-blood interface, it is helpful to hold the tube at a 45º 

angle.  

6.3 Centrifuge 30 min at 900xg, 18–20ºC, without brake.  

Note: Depending on the type of centrifuge, one may also need to set the 

acceleration speed to a minimum. 

6.4 Using a sterile pipet, remove the upper layer containing plasma and platelets and 

discard it.  

6.5 Using a fresh sterile pipet, transfer the mononuclear cell layer into another 

centrifuge tube.  

6.6 Wash cells by adding an excess of HBSS and centrifuge for 10 min at 400xg, 18–

20ºC. The HBSS volume should be ~3 times the volume of mononuclear layer.  

Note: Typically, 4 mL of blood/PBS mixture results in ~ 2 mL of mononuclear 

layer and requires at least 6 mL of HBSS for the wash step. We use 10 mL of 

HBSS per each 2 mL of cells. 

6.7 Discard supernatant and repeat wash step once more. 

6.8 Re-suspend cells in complete RPMI-1640 medium. Dilute cells 1:5 or 1:10 with 

trypan blue, count cells, and determine viability using trypan blue exclusion. If 

viability is at least 90%, proceed to step 6.9. 

6.9 Dilute the cells to a concentration of 1,000,000 viable cells per 1 mL and add 1 
mL of anti-human CD28 per each milliliter of the cell suspension or as directed in 
the kit instructions. 100 µL of this suspension will be added per well to the 
FLUOROSpot plate in step 7.2 (100,000 viable cells/well).   
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7. Setting up the FLUOROSpot Plate for Cell Treatments 

7.1 Add 100 µL of test samples and controls prepared in complete cell culture 

medium to the appropriate wells on the FLUOROSpot plate. 

Notes:  

a. The minimum number of replicates per each control and sample is 2. A higher 

number of replicates can also be used. 

b. It is advisable to use positive control samples in wells A1, A12, and H12 to 

facilitate stage calibration. Please consider the plate map in the Appendix of 

this protocol as an example of plate set-up.  

7.2 Add 100 µL of cells from step 6.9 to each well of the FLUOROSpot plate from 

step 7.1 and incubate in a cell culture incubator (37°C, 5% CO2, and 90–95% 

humidity) for 20–24 hours.  

Note: It is important to avoid disturbing the plates during the incubation step. 

7.3 At the end of the incubation, remove the plates from the incubator and continue 

with the detection of INFγ and IL-2 using the IFNγ/IL-2 FLUOROSpot kit 

according to the manufacturer’s instructions. 

Note: The procedure described in the following step is specific to the AID kit. 

When kits from other manufacturers are used, the steps detailed below may be 

different. 

 

8. Experimental Procedure for IFNγ and IL-2 Detection 

8.1 FLUOROSpot Reagent Preparation 

8.1.1 Warm all reagents to room temperature immediately before use, checking 

all buffers for the presence of precipitates which may form at low 

temperature during storage to ensure that they are fully dissolved. 

8.1.2 Wash Buffer: Make sure any visible crystals have been dissolved by 

gentle mixing. Add 50 mL of wash buffer to 450 mL of deionized water. 

8.1.3 Anti-human IFNγ and anti-human IL-2 secondary antibodies: Add 20 µL 

of anti-IFNγ and 20 µL of anti-IL-2 detection antibodies to 10 mL of the 

dilution buffer provided with the kit and mix well. 
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Note: Prepare this reagent immediately before step 8.2.2. 

8.1.4 Streptavidin-Cy3 and anti-FITC-green detection reagents: Add 50 μL of 

streptavidin-Cy3 and 33 μL of anti-FITC-green to 10 mL of the dilution 

buffer provided with the kit and mix well. 

Note: Prepare this reagent immediately before step 8.2.4. 

8.2 FLUOROSpot Experimental Procedure for IFNγ and IL-2 Detection  

8.2.1 Empty the wells of the culture plate from step 7.3 and wash the plate 5 

times with 200 μL per well of the wash buffer prepared in step 8.1.2, 

blotting the plate against a paper towel after the last wash to remove 

excess buffer. 

8.2.2 Add 100 µL/well of the secondary antibodies prepared in step 8.1.3 and 

incubate in a humid chamber at room temperature for 2 hours in the dark. 

8.2.3 Wash the plate 5 times with 200 μL per well of the wash buffer prepared 

in step 8.1.2, blotting the plate against a paper towel after the last wash to 

remove excess buffer. 

8.2.4 Add 100 µL of the detection reagents prepared in step 8.1.4 and incubate 

in a humid chamber at room temperature for 1 hour in the dark. 

8.2.5 Wash the plate 5 times with 200 μL per well of the wash buffer prepared 

in step 8.1.2, blotting the plate against a paper towel after the last wash to 

remove excess buffer. 

8.2.6 Add 100 µL per well of the Enhancer solution provided with the kit and 

incubate in the dark at room temperature for 15 minutes. 

8.2.7 Empty wells and blot the plate against a paper towel to remove excess 

enhancer solution. 

8.2.8 Turn the plate upside down and dry it uncovered overnight or at least for 3 

hours at room temperature in the dark. 

8.2.9 Read plate on the MultiSpot Reader. 

8.3 AID Reader Start-up and Plate Read (Refer to the instrument and software manuals 

for more detailed instructions.) 

8.3.1 Turn on the AID multispot reader, light sources, and computer. 

8.3.2 Launch the AID software and choose the EliSpot button. 
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8.3.3 Above the menu bar, check the user profile. If it reads User: NCL 

FluorospotUser go to step 8.3.6. If not, under File on the menu, click on 

Options, then click User Profiles in the newly opened Options window. 

Note: This protocol shares the software menu structure customized for the 

NCL. Other users will have similar structures specific to their 

laboratories. This instruction should be treated as an example to help new 

users with mastering the software in their laboratories. 
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8.3.4 In the user profile window, highlight NCLFluorospotUser, click Log In, 

enter the user password, and then click OK.  

Note: Each user should have their own password to operate this software 

on their computer. New users should create their own user profiles 

following the software’s manual. 

8.3.5 Click OK in the Options window to close. 
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8.3.6 Under the File menu click New. This should open a plate template with 

the ITA-42 settings. Remember to save the file under a new name 

 
 

8.3.7 To add information on cell lines used, cells/well, and treatments, click on 

the Tools menu, click Plate Layout, then click Edit Layout. This will 

open the Wells Properties window. 
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8.3.8 Under the Tools menu, choose Calibrate Stage and choose well A1; 

center and adjust imaging ring to encompass most of the well. Do the 

same for wells A12 and H12. Click Save and OK to save the stage 

calibration. 

 
 

8.3.9 On the plate map, use the mouse to select the wells to be read, then right 

click and highlight Read, Count & Analyze on the drop-down menu. 

8.3.10 After the plate has been read, click the Save button. 

 
9. Results and Analysis 

If necessary, the analysis algorithms and count settings may be changed from the AID 

default. This may be done before or after the plate is read. 

9.1 Once the plate has been read and analyzed, click the Excel button on the menu 

bar. This will open an Excel file with the spot counts and activities for each of the 

selected wells.  

9.2 Images of the plate and individual wells may be selected and captured using the 

Power Point button on the menu bar or by using the Print Screen function. 
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9.3 Plate and well information may be captured by clicking Tools, Plate Layout, then 

View Layout. 
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11. Abbreviations 

AID  Advanced Imaging Devices (Autoimmun Diagnostika) 

CF  cell-free 

FBS  fetal bovine serum 

PBMC  peripheral blood mononuclear cells 

PBS  phosphate buffered saline 

PC  positive control 

PHA-M Phytohemaglutinin M  

RT  room temperature 

T  test sample 

UNC  untreated negative control
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12. Appendix 

Example Plate Map 

 
 

Wells A1, A12, H12: PBMC + PC for stage calibration 

Rows A, H: Cell-free (CF) controls 

Rows B, C: Donor 1 

Rows D, E: Donor 2 

Rows F, G: Donor 3 

 
PC, positive control; CF, cell-free well;  
T, test sample (at 4 different concentrations, i.e., T1, T2, T3, T4) 

 
 

 1 2 3 4 5 6 7 8 9 10 11 12 

A PC Cell-free CF 
PC 

CF 
T1 

CF 
T2 

CF 
T3 

CF 
T4     PC 

B Untreated Untreated PC PC T1 T1 T2 T2 T3 T3 T4 T4 

C Untreated Untreated PC PC T1 T1 T2 T2 T3 T3 T4 T4 

D Untreated Untreated PC PC T1 T1 T2 T2 T3 T3 T4 T4 

E Untreated Untreated PC PC T1 T1 T2 T2 T3 T3 T4 T4 

F Untreated Untreated PC PC T1 T1 T2 T2 T3 T3 T4 T4 

G Untreated Untreated PC PC T1 T1 T2 T2 T3 T3 T4 T4 

H  Cell-free CF 
PC 

CF 
T1 

CF 
T2 

CF 
T3 

CF 
T4     PC 
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